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About This Book

VMware vCenter™ AppSpeed provides performance management and service-level reporting for services
running within virtual appliances. This book describes the procedures for installing the VMware vCenter
AppSpeed virtual appliance, including how to configure AppSpeed Server and deploy the AppSpeed probes
on the VMware® host machines within the datacenter network.

AppSpeed analyzes the traffic that flows between users, Web applications, and back-end servers. This analysis
provides visibility into multitier services and enables you to identify performance problems that originate from
inadequate resource allocation and service problems.

Intended Audience

This guide is intended for anyone who wants to install the AppSpeed virtual appliance on a VMware
vSphere™ Server.

The information is written for experienced Windows or Linux system administrators who are familiar with
virtual appliance technology and datacenter operations.

Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your
feedback to docfeedback@vmware.com.

Technical Support and Education Resources

The following technical support resources are available to you. To access the current version of this book and
other books, go to http://www.vmware.com/support/pubs.

Online and Telephone To use online support to submit technical support requests, view your product
Support and contract information, and register your products, go to
http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support
for the fastest response on priority 1 issues. Go to
http://www.vmware.com/support/phone_support.html.

Support Offerings To find out how VMware support offerings can help meet your business needs,
go to http://www.vmware.com/support/services.

VMware Professional VMware Education Services courses offer extensive hands-on labs, case study

Services examples, and course materials designed to be used as on-the-job reference
tools. Courses are available onsite, in the classroom, and live online. For onsite
pilot programs and implementation best practices, VMware Consulting
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Services provides offerings to help you assess, plan, build, and manage your
virtual environment. To access information about education classes,
certification programs, and consulting services, go to
http://www.vmware.com/services.
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VMware vCenter AppSpeed
Installation

You install AppSpeed on a VMware host machine that resides within the datacenter network and integrates
with the VMware vSphere Client. You install one or more AppSpeed probes on each host to be monitored.

This chapter includes the following topics:

“Installation Prerequisites,” on page 7

“Installation Workflow,” on page 9

Installation Prerequisites

Before installing AppSpeed, review the system and deployment requirements.

A variety of VMware ESX™ versions support AppSpeed.

Server: ESX 3.5.x or 4.0.x Probes: ESX 3.0x, 3.5.x, or 4.0.x

vSphere 4.x

System Requirements

Before you install AppSpeed, make sure that you have the necessary administrator privileges and system
requirements.

Review these system requirements before you install AppSpeed.

VMware, Inc.

You must have admin-level access to vCenter Server for the automated installation process.
You must define routable IP addresses for servers and probes.

VMware recommends that you donot use DHCP because the IP address of AppSpeed Server might change
after setup is complete. However, if you do use DHCP, you do not need routable IP addresses.

If HTTPS sites are to be monitored, you require the SSL private keys.
You must have Administrator privileges on the client machine to install Adobe Flash Player 10.

Adobe Flash Player 10 must be installed as an ActiveX Control; therefore, it must be downloaded using
Internet Explorer.

VMware recommends that you synchronize the time on the hosts on which AppSpeed Server and the
AppSpeed probes will be installed. If the time is not synchronized, AppSpeed might lose data and
experience delays in the mapping process. To synchronize the time, set an NTP server in the Configuring
Time option for each ESX host in vCenter.
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Deployment Considerations

Your must have sufficient system resources to deploy AppSpeed.

When planning your AppSpeed deployment, make sure that you have these system resource requirements.

B Server

B 40GB hard disk drive

Virtual CPUs are created as part of the AppSpeed deployment. In addition, AppSpeed reserves

B 4GB RAM
®m 2 vCPUs
3000MHz.
B Probes

B 5GB hard disk drive
B (0.5GB RAM
®m 2 vCPUs

Virtual CPUs are created as part of the AppSpeed deployment. Two vCPUs require no more than the
equivalent resources of a single physical CPU.

Port Requirements

AppSpeed requires that specific ports be open on your firewall.

Table 1-1. Open Port Requirements

Server Connection

Required Open Ports

AppSpeed Server to vCenter Server

TCP port 443 Connects to vCenter Server for the vCenter interface.
Port 443 is the vCenter default Web service port, but you can configure a
different TCP port in vCenter.

TCP port 80 Connects to vCenter Server for the vCenter proxy interface.

This port is used only during setup to verify that the vCenter proxy is
configured correctly.

Port 80 is the vCenter default proxy service port, but you can configure a
different TCP port in vCenter.

vCenter Client to AppSpeed Server

TCP ports 80 and 443

Connects to AppSpeed Server (Web interface). You can configure a
different TCP port during AppSpeed setup.

AppSpeed Server and probe communication

TCP port 1194 Connects to AppSpeed Server (OpenVPN over a TCP connection).
UDP port 123 Connects to AppSpeed Server (NTP).
TCP port 22 Connects to the probes if you want to access the probes from outside the

VPN.

vSphere to vCenter Server

TCP port 80

Connects to vCenter Server (vCenter proxy interface).

Port 80 is the vCenter default proxy service port, but you can configure a
different TCP port in vCenter.

VMware, Inc.



Chapter 1 VMware vCenter AppSpeed Installation

Installation Workflow

AppSpeed is a virtual appliance in Open Virtualization Appliance (OVA) format. The AppSpeed plug-in is
installed in the vSphere Client.

You perform the installation and setup process in various stages.

1  Import the OVA file and configure AppSpeed Server (see Chapter 2, “Installing and Configuring
AppSpeed Server,” on page 11).

2 Add avalid AppSpeed license key (see “Add a License,” on page 13).
3  Install the AppSpeed probes (see Chapter 3, “Deploying AppSpeed Probes,” on page 15).

4  Verify the successful deployment of the probes (see “Verifying Probe Installation,” on page 17).

VMware, Inc. 9
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Installing and Configuring AppSpeed
Server

You can install AppSpeed Server on any ESX 3.5 host, or later, that is managed by vCenter Server for the
environment you want to monitor. AppSpeed is provided as an OVA file.

This chapter includes the following topics:

B “Install AppSpeed Server on the vSphere Client,” on page 11
B “Configure AppSpeed Server,” on page 12

B “Define AppSpeed Users,” on page 13

B “Add a License,” on page 13

B “View Unmapped Traffic,” on page 13

Install AppSpeed Server on the vSphere Client

The first step in the installation process is to import the OVA file in the installation package to the
vSphere Client.

Prerequisites

You must have administrator privileges to import the OVA file.

Procedure

1  Savethe OVA filein the samelocation as the other files in the installation package, which mustbe alocation
that you can access from the vSphere Client.

In the vSphere Client, select File > Deploy OVF Template.
Select Deploy from File and click Browse to locate the OVA file.
Click Next and click Next again.

Read and accept the End User License Agreement, and click Next.

AN O s W N

Type a name for the virtual appliance server in the Name text box.
The name must be unique in the vSphere Client.
7 Select the location for the deployed template and click Next.

8  From the Host/Cluster tree in the upper-right pane, select the ESX host on which to install the virtual
appliance, and click Next.

The host must be managed by vCenter Server for the environment that you want to monitor.

If you select a cluster, you might be required to select a specific host in that cluster.

VMware, Inc. 11
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9  (Optional) Select the datastore on which to store the files for the virtual appliance, and click Next.

10 From the Management Network menu, select a network that has access to the other machines and to
vCenter Server to use to manage the probes.

AppSpeed Server uses this network to deploy and communicate with probes deployed on other hosts.
11 Click Next.
12 Review the installation summary and click Finish to begin installation.

When the installation is complete, the virtual appliance is added in the vSphere Client.

What to do next

In the vSphere Client, select Home > Inventory > Hosts and Clusters, and on the Getting Started tab click
Power on the virtual machine to start the virtual appliance.

Configure AppSpeed Server

You configure AppSpeed Server from the vSphere Client.

Procedure
1  Power on the AppSpeed virtual machine.
2 Ensure that the virtual machine is selected in the vSphere inventory tree, and click the Console tab.
3 At the login prompt, type setup.
To accept the default value of a parameter, press Enter, or specify an alternative value.
The current value for each parameter appears in brackets.

If you need to exit the console after you begin the setup, press Ctrl+Alt. Click in the console again to
reinitiate the setup.

4  (Optional) Select a setting for the network management card.

a TypeY to use DHCP settings.

b  TypeN to set a fixed IP address.

You are prompted to set the IP address, netmask, and gateway for the management card.

¢ (Optional) If you do not want to specify the gateway, type 6.0.60.6.
5  Set the AppSpeed time zone.

If the time zone list does not fit in the console window, press question mark (?) to view all locations.
6  Configure the vCenter IP address, user name, and password.
7  (Optional) Specify the port number.

Type the port number immediately after the IP address, preceded by a colon (:). For example,
10.23.89.89:8080 indicates port 8080 on IP address 10.23.89.89.

8  Seta unique namespace for this AppSpeed Server.

The namespace can consist of up to 26 lowercase letters, digits, and dashes.
9  Confirm whether AppSpeed must be installed in such a way that vSphere cannot connect to it directly.
10 Confirm that you want to use the default vCenter port settings, or specify different port settings.

11 Press Enter to confirm that you want to complete the setup process.

12 VMware, Inc.



Chapter 2 Installing and Configuring AppSpeed Server

12 (Optional) Press Ctrl+C to reinitiate the setup process and change any parameter values.
If you reinitiate the setup process, the previous values are retained. You can change the values as needed.

13  When prompted, review the setup summary and press Enter to accept the settings and complete the setup
process.

What to do next
Install AppSpeed probes. See “Install an AppSpeed Probe,” on page 16.

If you want to install more than one AppSpeed Server, see Chapter 5, “Using Multiple AppSpeed Servers,” on
page 21.

Define AppSpeed Users

Only users who are assigned the AppSpeed User role on the AppSpeed Server virtual machine or have
AppSpeed user privileges incorporated in another role can access, view, or manage AppSpeed. AppSpeed
privileges are automatically added to the Administrator role during AppSpeed Server setup. You can also add
AppSpeed privileges to other existing roles.

Procedure

1 Inthe vSphere Client, right-click the appropriate AppSpeed Server in the Inventory tree.
Select Add Permission.

In the Assign Permissions window, click Add to add a user or group of users.

In the list in the Assigned Role pane, select AppSpeed User.

62 B O N S

Click OK.

Add a License

You must have an AppSpeed license to monitor servers. You can deploy up to eight probes if you are using
an evaluation license.

Procedure

1  Inthe AppSpeed menu bar, click Administration.

2 Inthe page selection bar, click License.

3 Click Add License.

4  Type the license key provided by VMware in the text box and click OK.

The license key is validated, and its details are added on the License page.

View Unmapped Traffic

You can view the unmapped servers and transactions detected on the network. Unmapped objects are not yet
mapped to specific services. The number of unmapped objects typically decreases over time, as AppSpeed
maps the environment.

Prerequisites

To view unmapped traffic on HTTP sites that incorporate SSL protection, you must first configure the SSL keys
for each endpoint where AppSpeed detects SSL traffic. See Chapter 4, “Managing SSL Keys,” on page 19.

VMware, Inc. 13
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Procedure
1  Inthe AppSpeed menu bar, click Mapping.
2 In the page selection bar, click Unmapped.
3 View the status information for the unmapped traffic.
B Server: Name of the server. Available on the Servers tab only.
B Name: Name of transaction. Available on theTransactions tab only.
B Endpoint: IP address and ports used by the server. Available on the Servers tab only.
B Latency: Average and standard deviation (STDEV) latency rates for the server or transaction.

B Hits: Total number of hits in the specified time frame for the server or transaction, and rate of hits
per second.

B Throughput: Total throughput in the specified time frame for the server or transaction, and the
average throughput.

B Errors: Average rate of errors, as a percentage, for the server or transaction.

14 VMware, Inc.



Deploying AppSpeed Probes

To monitor traffic, you install at least one AppSpeed probe on one or more hosts. Each probe can monitor up
to three vSwitches.

You can install more than one probe on the same host to monitor additional vSwitches. The probe settings,
including the management network, storage device, and monitored vSwitches, are configured as part of the
probe installation process.

You can configure probes to monitor Cisco Nexus 1000V switches. See “Monitor Cisco Nexus 1000V
Switches,” on page 18.

You can add and remove probes. See “Install an AppSpeed Probe,” on page 16 and “Delete Probes,” on
page 18.

To modify the probe configuration, see the VMware vCenter AppSpeed User’s Guide.
The AppSpeed probe deployment process automatically makes these changes in the vCenter.

B Creates a snapshot of the AppSpeed Server virtual machine if one does not already exist. To save disk
space, you can remove the AppSpeed Server virtual machine snapshots after the probe installation is
complete.

B Creates the AppSpeed Probes folder.
B Creates promiscuous port groups for the selected vSwitches.

B Creates a probe by creating a linked clone of AppSpeed Server. AppSpeed Server is cloned as the probe,
then the linked clone is deleted. If an error occurs, AppSpeed will try up to three times to create the probe.
The virtual machine of the probe has the appropriate hardware settings, including CPU and memory
reservation.

B Reconfigures the probe's cluster so that the probe is not subject to VMware Distributed Resource Scheduler
(DRS) and VMware High Availability (HA), ensuring that the probes remain on the host on which they
were deployed.

B Powers on the probe.

®  Edits and reconfigures the probe's settings.

This chapter includes the following topics:

B “Install an AppSpeed Probe,” on page 16

B “Configure the Probe for Each Host Entry,” on page 16
B “Power Probes On or Off,” on page 17

B “Verifying Probe Installation,” on page 17

VMware, Inc. 15
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B “Delete Probes,” on page 18

B “Monitor Cisco Nexus 1000V Switches,” on page 18

Install an AppSpeed Probe

You can install a probe on one host at a time or multiple hosts at the same time. You can also install more than
one probe on the same host.

If you want to install a probe to monitor a Nexus 1000V switch, see “Monitor Cisco Nexus 1000V Switches,”
on page 18.

Procedure

1  In the vSphere Client, select Home > Solutions and Applications and click the <AppSpeed_namespace>
icon.

A new Services tab appears in the vSphere Client interface.

2 (Optional) If the <AppSpeed_namespace> icon does not appear, verify that the AppSpeed plug-in is
enabled in the Plug-ins menu.

3 Inthe AppSpeed menu bar, click Administration.
4  Inthe page selection bar, click Deployment.
5  Select the hosts or clusters on which to install a probe and click the Install Probes button.

A probe is installed on each selected host, even if another probe is already installed on the host. When you
select a cluster, each host that it contains is selected.

The Probe Installation window displays a separate entry for each host that you select. Each entry appears
in a separate pane.

6  (Optional) You can configure the probe for each probe entry, as described in “Configure the Probe for
Each Host Entry,” on page 16.

7 (Optional) To add an additional probe to a host, click Install another probe on this host at the bottom of
the host entry and configure the probe.

8  When you finish adding host-probe combinations, click the Install Probes button.
9  Review the installation information, and click OK.
To change the settings, click Back.
The Probe Status column in the Probes Management window shows the installation progress.

The probe is added to the <namespace> Probes folder in the vSphere Client and powered on.

What to do next

Delete the AppSpeed Server virtual machine snapshots after the probe installation is complete.

Configure the Probe for Each Host Entry

16

You can configure the probe for each host entry.
The probe also connects to the management network you specified, but it does not monitor the network.

To configure probes to monitor Cisco Nexus 1000V switches, see “Monitor Cisco Nexus 1000V Switches,” on
page 18.

VMware, Inc.



Chapter 3 Deploying AppSpeed Probes

Procedure

1  Type the name of the probe in the Probe Name text box.
If you do not specify a name, a name based on the AppSpeed Server name is used.

2 From the Storage menu, select the storage device on which you want the probe to reside.
Local storage enables faster probe deployment.

3 From the Management Network menu, select the network to use to manage the probes.
a  Select up to three monitoring vSwitches.

The vSwitches sniff traffic on the configured management network. By default, the first three available
vSwitches are selected.

b  Select either DHCP or Static IP.

If you select Static IP, you must type values for the IP and Network fields, and (optionally) the
Gateway field.

4  Click Install Probes.
5 Review the summary and click OK.

The probe is installed. Installation might take some time.

Power Probes On or Off

You can power probes on or off from the Probes Management window.

Procedure
1 Inthe AppSpeed menu bar, click Administration.
2 Inthe page selection bar, click Deployment.

3 Select the check boxes for one or more probes and click Power On or Power Off.

Verifying Probe Installation
After you have installed and deployed a probe, you can check whether it has been successfully installed.
You can check the probe status in any of these locations.
B Recent Tasks pane of the vSphere Client
B Probes Management window of the AppSpeed user interface
B Servers tab or Transactions tab of the Unmapped Traffic page

If the probe is successfully installed and deployed, the status is Running. If there is active traffic on the part of
the network that the probe is monitoring, the traffic throughput is is shown.

The traffic throughput can be zero if there is no traffic on the monitored vSwitches or if a problem occurs with
the installation. If the problem persists and you know that traffic is present, see Chapter 9, “Troubleshooting
AppSpeed Installation and Deployment,” on page 31.

VMware, Inc. 17
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Delete Probes

If you do not want to monitor the traffic on a specific host, you can remove the probes. If you do not want to
monitor specific vSwitches on a host, you can delete the probe that is monitoring those switches.

Procedure

1 Inthe AppSpeed menu bar, click Administration.

2 Inthe page selection bar, click Deployment.

3 Select the check boxes for one or more probes on one or multiple hosts, and click Delete Probe.
4  Click OK to confirm.

The probe is removed from the selected hosts only.

Monitor Cisco Nexus 1000V Switches

You can use AppSpeed to monitor Cisco Nexus 1000V switches.

Refer to the Nexus documentation for creating a port group and configuring port mirroring.
Prerequisites

You must create a port group for each Nexus 1000V switch that you want AppSpeed to monitor. The port
group name must be in the format <name_of_Nexus_switch>_AppSpeed, for example, switch13_AppSpeed.

Procedure
1 Install an AppSpeed probe.
2 Configure port mirroring.
a  On the Cisco Nexus 1000V switch, specify the server ports to monitor as the source ports.

b Onthe Cisco Visual Switch Manager, identify the interface on which the AppSpeed probe was added
to the port group (for example, Vethernetl) and specify that interface as the destination port.

The probes are powered on and monitoring the Nexus 1000V switches begins.

18 VMware, Inc.



Managing SSL Keys

To monitor traffic on HTTPS sites that incorporate SSL protection, you must configure the SSL keys for each
endpoint and the IP address and port pair where AppSpeed detects SSL traffic.

AppSpeed supports SSL key monitoring only for HTTPS sites.

This chapter includes the following topics:

“View SSL Key Information,” on page 19
“Add an SSL Key,” on page 19

View SSL Key Information

You can view the existing SSL key configuration to determine for which endpoints you want to provide an
SSL key.

Procedure

1
2
3

In the AppSpeed menu bar, click Mapping.

In the page selection bar, click SSL Management.

View the secure site endpoints for which AppSpeed cannot monitor traffic without a key.

B The Pending SSL Endpoints table lists the endpoints for which valid SSL keys are required.

B The Monitored SSL Endpoints table lists the endpoints for which valid keys exist and AppSpeed is
monitoring.

Add an SSL Key

You can assign a key to a pending endpoint to enable AppSpeed to monitor its traffic.

Prerequisites

You must extract the SSL files from the Web server to obtain the key.

Procedure

1  Inthe AppSpeed menu bar, click Mapping.

2 In the page selection bar, click SSL. Management.

3 Inthe SSL Pending Endpoints table, select the endpoints and click Add/Update SSL key.

4  Browse to and open the key file.
The key is assigned to the selected endpoints. The endpoint moves from the SSL Pending Endpoints table
to the Monitored Endpoints table.

VMware, Inc. 19
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Using Multiple AppSpeed Servers

You can use multiple AppSpeed Servers to monitor a large environment. When multiple AppSpeed Servers
are installed on a single vCenter server, you can centrally manage AppSpeed through a single user interface.

When using multiple AppSpeed Servers, keep in mind the following information regarding licensing and
monitoring.

B You can apply your license key to multiple AppSpeed Servers as long as the number of monitored CPUs
does not exceed the number of CPUs defined in your license.

B Because the same virtual machine might be monitored by two or more AppSpeed Servers, the licenses are
counted accordingly, once for each server. However, only the actual number of CPUs that are being
monitored are relevant to your AppSpeed license.

B Topology and monitoring information is not shared between the servers. The same service can be mapped
in two or more servers. The monitoring data in the two servers might be different if the two servers detect
different traffic. Changes in the configuration of a service in one AppSpeed Server, such as names and
thresholds, are not reflected in other AppSpeed Servers.

B One AppSpeed Server can map the management traffic of a different AppSpeed Server as a service.

B When you use the vSphere Client, you cannot connect to AppSpeed Servers that are located on different
vCenter Servers in a linked vCenter Server environment. You must use the vSphere Client to log in to each
vCenter Server on which AppSpeed Servers are located.

Switch Between AppSpeed Servers

When you activate AppSpeed from a vSphere client on which more than one AppSpeed Server is installed,
you can select which server to connect to.

Procedure
1  In the vSphere Client, select Home > Solutions and Applications.
2 Click the AppSpeed Server that you want to run.

The AppSpeed Server user interface opens.

VMware, Inc. 21
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Extracting SSL Files

To obtain the SSL keys, you can extract SSL files from the Web server. The extraction procedure varies according
to the type of Web server.

AppSpeed supports Apache, Microsoft IIS 6.0, and Microsoft IIS 7.0 servers.
This chapter includes the following topics:

B “Extract SSL Files from an Apache Server,” on page 23

B “Extract SSL Files from a Microsoft IIS 6.0 Server,” on page 23

B “Extract SSL Files from a Microsoft IIS 7.0 Server,” on page 24

Extract SSL Files from an Apache Server

You can extract the SSL files from an Apache server.

Procedure
1  Inthe Apache conf directory, open the http.conf file.

The file name depends on the version of Apache Server that you have installed, for example, /etc/httpd/
conf/httpd.conf.

2 Locate the SSLCertificateKeyFile command on the SSL site.

3 Save a copy of the file that appears under SSLCertificateKeyFile as [cluster].key and transfer it to the
vSphere Client machine.

What to do next

Upload the key file to the AppSpeed Server.

Extract SSL Files from a Microsoft lIS 6.0 Server

You can extract the SSL files from a Microsoft IIS 6.0 server. Files are extracted by exporting the IIS key file.

During the export process, a password is requested to protect the key. If a password is assigned, note this
password. The password is required when you import the key into AppSpeed.

Procedure

1  Select Start > Programs > Administrative Tools > Internet Information System (IIS) Manager.
Expand the COMPUTERNAME (local computer) tree in the left pane, and expand the Web Site tree.
Right-click Default Web Site and select Properties.

=~ W N

Select the Directory Security tab and click Server Certificate.

VMware, Inc. 23



VMware vCenter AppSpeed Installation and Upgrade Guide

Click Next, select Export the current certificate to a PFX file, and click Next again.
Select a file to write the exported certificate and key to and click Next.
Type the password with which to encrypt the key.

Re-type the password in the Confirm Password text box.

oo e NN o O

Click Finish.

What to do next

Transfer the PFX file to the vSphere Client machine and upload it to the AppSpeed Server.

Extract SSL Files from a Microsoft IIS 7.0 Server

You can extract the SSL files from a Microsoft IIS 7.0 server. Files are extracted by exporting the IIS key file.

Prerequisites

During the export process, a password is requested to protect the key. If a password is assigned, note this
password. The password is required when you import the key into AppSpeed.

Procedure
1  Select Start > Programs > Administrative Tools > Internet Information System (IIS) Manager.

2 Expand the COMPUTERNAME (local computer) tree in the left pane, and double-click the Server
Certificates icon in the middle pane.

3 Right-click the certificate and select Export.
A PFX file is created.

What to do next

Transfer the PFX file to the vSphere Client machine and upload it to the AppSpeed Server.
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Upgrading AppSpeed

You can upgrade AppSpeed Server without deleting the existing installation. After you upgrade AppSpeed,
increase the size of the virtual hard disk. When AppSpeed detects that the hard disk is reaching full volume,
it shuts down.

Upgrading AppSpeed comprises the following tasks:
1  Downloading the ISO file for the upgrade.
Creating a new virtual hard disk.

Formatting the new disk.

Copying the data from the original virtual hard disk to the new disk.

(62 B O B ]

Removing the original virtual hard disk from the AppSpeed virtual machine and deleting the files.
This chapter includes the following topics:

B “Upgrade AppSpeed,” on page 25

B “Increase the Disk Size of an AppSpeed Virtual Machine,” on page 26

B “Format an AppSpeed Virtual Hard Disk,” on page 26

B “Delete a Virtual Hard Disk After Copying,” on page 27

Upgrade AppSpeed

You use the ISO image that VMware provides to upgrade AppSpeed. The upgrade process reboots AppSpeed
Server and recreates all AppSpeed probes. This might take some time.

You can upgrade AppSpeed without uninstalling the previous version.

Note Exchange is not supported after upgrading.

Procedure
1  Download the ISO file from the VMware Web site and save it to a location on your local disk.
2 In the vSphere Client, connect AppSpeed Server to the ISO file.

a  Select the AppSpeed Server virtual machine in the vSphere Client inventory tree.

b  Click the Connect CD/DVD devices icon and select Connect to ISO image on local disk from the
menu.

¢ Browse to the location of the ISO file.

3 Log in to the AppSpeed Server console as the console user.
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4 From the default console shell, run the command upgrade_AppSpeed.
5 Press Enter to run the upgrade script.

After AppSpeed Server boots from the ISO image, it continues the upgrade process, including rebooting
and recreating the probes. This process can take up to one hour.

A message appears when the AppSpeed Server upgrade is complete.
6  When prompted, disconnect the ISO file from the AppSpeed Server virtual machine.

The probes are recreated in the new version. You can monitor the redeployment process from the
AppSpeed Probes Deployment window.

What to do next

B Increase the disk size of the AppSpeed virtual machine. See “Increase the Disk Size of an AppSpeed Virtual
Machine,” on page 26.

B Verify the deployment of the probes. See “Verifying Probe Installation,” on page 17.

Increase the Disk Size of an AppSpeed Virtual Machine

When you upgrade AppSpeed, increase the volume of your hard disk to reduce the possibility that the disk
becomes full. When the disk is full, the monitoring process stops.

Prerequisites

Power off the AppSpeed virtual machine.

Procedure

1  In the vSphere Client inventory, right-click the AppSpeed virtual machine that you want to modify, and
select Edit Settings.

The Virtual Machine Properties window appears.
In the Hardware tab, click Add.

Select Hard Disk and click Next.

Select Create a new virtual disk and click Next.

Under Capacity, set the disk size to 38 GB and click Next.
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Click Next, and in the Ready to Complete screen, click Finish.
A new virtual hard disk is created.
7  Click OK.

The virtual machine is reconfigured.

What to do next

Format the new virtual hard disk, and copy the contents of the original disk to the new disk. See “Format an
AppSpeed Virtual Hard Disk,” on page 26.

Format an AppSpeed Virtual Hard Disk

26

After you create an AppSpeed virtual hard disk, you must format it and copy the contents of the original virtual
hard disk to the new one.

Prerequisites

Create a new virtual hard disk.
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Procedure
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Power on the AppSpeed virtual machine.

At the login prompt in the vSphere Client console, type console.
Type stop_appspeed.

Type copy_appspeed_data_disk.

AppSpeed copies the data from the original virtual hard disk to the new virtual hard disk. During the
process, error messages might appear. You can ignore these messages, unless the copy process stops before
completion.

A success message appears when the formatting is complete.

The new virtual hard disk includes the information that was on the original disk.

What to do next

Delete the original virtual hard disk. See “Delete a Virtual Hard Disk After Copying,” on page 27.

Delete a Virtual Hard Disk After Copying

After you have copied the contents of the original virtual hard disk to the new virtual hard disk, you must
remove the original disk from the AppSpeed virtual machine and delete the files.

Prerequisites

Copy the contents of the original virtual hard disk to a new virtual hard disk.

Procedure

1  Shut down the AppSpeed virtual machine.

2 Right-click the AppSpeed virtual machine in the vSphere Client inventory and select Edit Settings.
The Virtual Machine Properties window appears.

3  In the Hardware tab, select Hard disk 2 and click Remove.

4  Select Remove from virtual machine and delete files from disk, and click OK.
The virtual machine is reconfigured.

5  After the reconfiguration process is finished, power on the virtual machine.

The new virtual hard disk has been renamed Hard disk 2.

The original virtual hard disk is deleted and the AppSpeed virtual machine uses the new, larger virtual hard
disk.

VMware, Inc.
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Uninstall AppSpeed

To completely remove AppSpeed from your system, you must delete AppSpeed probes, uninstall AppSpeed,
and remove AppSpeed users.

Procedure
1 Inthe AppSpeed menu bar, click Administration.
In the page selection bar, click Deployment.

Delete all probes by selecting the check boxes and clicking Delete Probe.
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(Optional) If some probes remain, delete them from the vSphere Client.
a  Power off the virtual machine.

b  Right-click the machine name and select Delete from Disk.

5 Delete the promiscuous port groups created by AppSpeed.

a  Inthe vSphere Client, select a host that has a probe installed, click the Configuration tab, and click
the Networking link.

b For each vSwitch, delete any port groups called vSwitch n AppSpeed, where 7 is a unique number for
the vSwitch name.

¢ Repeat this process for each host on which a probe is installed.

6  In the vSphere Client, select Home > Inventory > VMs and Templates and delete the <namespace>
Probes folder from each datacenter in which it exists.

7 Unregister the AppSpeed Server from vCenter.
a  Inthe vSphere Client, open the AppSpeed Server console.
b  Type stop_appspeed.
¢ Type unregister.
d  Restart the vSphere Client.
8  Delete the virtual machine on which AppSpeed Server was deployed from the vSphere Client.
a  Power off the virtual machine.
b  Right-click the machine name and select Delete from Disk.

9  Select Home > Administration > Roles and remove AppSpeed User privileges and the AppSpeed User
role.
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Troubleshooting AppSpeed
Installation and Deployment

If you encounter problems when installing and deploying AppSpeed, use this troubleshooting information.

This chapter includes the following topics:

“AppSpeed Setup Errors,” on page 31

“Navigation to Web Page Cancelled,” on page 32

“AppSpeed View Does Not Load,” on page 33

“Unable to Connect to AppSpeed,” on page 33

“AppSpeed Server Namespace Is Not Recognized,” on page 34

AppSpeed Setup Errors

You might have problems while setting up AppSpeed.

Failed to Register AppSpeed with vCenter Server on page 31

You are unable to register AppSpeed with vCenter Server.
vCenter Server HTTPS Web Service Port Does Not Work with Port 443 on page 32

You are unable to complete setup because the vCenter Server HTTPS Web service is not working.

vCenter Server HTTPS Web Service Port Traffic Is Blocked on page 32

You are unable to complete setup because the vCenter Server HTTPS Web service is not working.

Failed to Register AppSpeed with vCenter Server

You are unable to register AppSpeed with vCenter Server.

Problem

Setup fails and an error message appears.

Failed to register AppSpeed with vCenter Server:

Unable to find AppSpeed Server on the configured vCenter Server.

Cause

You entered the IP address of a vCenter Server that is not the server on which AppSpeed was installed.

Solution
1  Verify the vCenter Server IP address.
2 Run setup again and enter the correct IP address.
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vCenter Server HTTPS Web Service Port Does Not Work with Port 443

You are unable to complete setup because the vCenter Server HTTPS Web service is not working.
Problem

Setup fails and an error message appears.

Connection timed out. Verify the vCenter address and try again.

Cause

The vCenter Server HTTPS Web service port is not configured to work with the default port 443.
Solution

1 Check the vCenter Server Web service port.

2 Run setup again, and type <vCenter_IP>: <HTTPS_Port> in the vCenter parameters section.

vCenter Server HTTPS Web Service Port Traffic Is Blocked

You are unable to complete setup because the vCenter Server HTTPS Web service is not working.

Problem

Setup fails and an error message appears.

Connection timed out. Verify the vCenter address and try again.

Cause

The vCenter Server HTTPS Web service portis blocked to trafficbetween AppSpeed Server and vCenter Server.
Solution

1 Verify with IT that the vCenter Server HTTPS Web service port on the firewall is open between
AppSpeed Server and vCenter Server.

2 Run setup again.
3 (Optional) If the problem persists, complete the following steps.
a  As the console user, log in to the AppSpeed Server virtual machine and run shell.

b Use Telnet to access the vCenter Server IP with the vCenter Server HTTPS Web service configured to
port 443 to verify that the port is open.

Navigation to Web Page Cancelled

32

You cannot load the AppSpeed user interface.

Problem

After you click the <AppSpeed_namespace> icon in the vSphere Client from Home > Inventory > Solutions
and Applications, the following error message appears:

Navigation to the web page was cancelled.

Cause

The AppSpeed Server is not running.
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Solution
1 Inthe vSphere Client, log in again to the virtual machine.

2 Click Refresh in the error message Web page.

AppSpeed View Does Not Load

You cannot load the AppSpeed view.

Problem

Clicking the AppSpeed icon in the vSphere Client does not load the AppSpeed view.

Cause

A connection to AppSpeed Server cannot be established or proxy settings are incorrect. This type of error is
usually preceded by one of the following messages:

Received a connectivity error.

URL Error received.

Solution

1 Verify with IT that port 80 is open on the firewall.
Restart the vSphere Client.

Wait a few minutes for the AppSpeed user interface to load.
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If the user interface still does not load, reinstall the user interface from the plug-in window.

Note You do not have to uninstall the user interface before reinstallation.

Unable to Connect to AppSpeed

The user interface is unable to communicate with AppSpeed Server.

Problem

The user interface cannot connect to AppSpeed.

Cause

Storage used by AppSpeed Server was disconnected, causing the file system to respond as a read-only file
system.

To verify the cause, log in to the console on the AppSpeed virtual machine and run commands such as
start_AppSpeed or restart_AppSpeed. If the file system is read-only, you receive a message similar to the
following;:

OS Error: [Error 30] Read-only file system: 'twistd.pid’

Solution
1  Validate that the storage is running.

2 From the vSphere Client, reboot the AppSpeed Server virtual machine to reinitialize the file system.
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AppSpeed Server Namespace Is Not Recognized

34

When attempting to connect to the AppSpeed user interface, the namespace that you specify is not recognized.
Problem

When specifying the namespace of AppSpeed Server, an error message is returned.

Cause

You entered an incorrect namespace

Solution

1  In the vSphere Client, log in to AppSpeed Server as console.

2 Run the show_namespace command.

The command returns the namespace value that was specified during setup or through vCenter settings.

3 Use the namespace value to connect to the AppSpeed user interface.
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